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Q-TOF User’s Booklet 

 

Enter your username and password to login.  After you login, the data acquisition program will 

automatically start. 
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This data acquisition window will come up after the program has loaded: 

 

 

 

Depending upon your application, please go to the appropriate page in this booklet. 

For intact proteins, please go to page 3. 

For peptides, please go to page 16.  

For small molecules, please go to page  
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Intact Proteins 
1) Go to the File menu, and click on Open Method….. 

 

2) Choose the method called “Student_Intact_Proteins”. 
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3) Install the Poroshell 300SB-C8 column.  Note that the flow direction is left to right. 

The left side is the high pressure side, and requires a nut and ferrule.  The low pressure side on 

the right only requires a one-piece PEEK fitting. 

 

 
 

 

 

 

Flow direction is left to right  

 

High Pressure Side 

Low Pressure Side 
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4) Set the initial solvent flow to 95% acetonitrile with 0.1% formic acid, and 5% water with 0.1% 

formic acid, at a flow rate of 0.5 ml/min, using the “1290-Bin Pump” tab on the method editor.  

Click on the “Apply” button. 
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Click on Apply after making any changes   
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5) Put the instrument into “On” mode. 

 
 

 

 

 

6) Turn on the Reference Mass ions, using the Q-TOF and Ref  Mass tabs. 

 

 
 

Click on the On button  

 Click on the Apply Now button to 

turn the reference masses on. 
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7) After the column has conditioned for 5 minutes, change the gradient to 95% water with 0.1% 

formic acid, and 5% acetonitrile with 0.1% formic acid. 

 

8) Sample Preparation: 

The protein sample should be desalted, and dissolved in water with 0.1% formic acid.  The 

concentration should be at least 0.1 mg/ml.  The minimum volume would be 10 ul if using a 

conical bottom insert in the vial.   

 

Important!  The sample must be filtered to remove any particulate matter. 

 
 

9) Place the sample in the Autosampler compartment, and note its position.  It’s position is 

designated by the plate number, followed by a dash, and then the well letter and number.  For 

example,  P1-D1 would be plate 1, row D and column 1. 

 

Typical 0.2 ml vial insert. 

 

 P1-D1 
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Click on the “Sample” tab in the method area near the bottom of the page, to set up the data 

acquisition. 

The required parameters to set are the sample position in the autosampler tray, a data file name, 

comment, and injection volume. 

 
 

10) Click on the Start Run icon. 

 

  

Start Run  
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Data Workup After the Run Has Completed 

 

1) Launch Agilent Qualitative Analysis Program. 

 

2) After the program comes up, go to the Tools menu, and Configure Workflow for “Bioconfirm”.  

Click OK and click on “No” to saving method changes. 

 

3) On the left hand side, expand the “General” heading, and click on “Extraction Data Format”.  

For Chromatogram data format, click on “Centroid when available”, and for Mass spectral data 

format, click on “Profile, when available” 
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4) Next, open your data file, using File and Open. 

 

5) On the HPLC chromatogram, left-click and drag across an area of background baseline with no 

peaks, in order to highlight that area.  Then right-click the mouse to obtain a menu, and left-

click “Extract MS Spectrum to Background”.  You should see a background spectrum in the 

MS Spectrum window, showing mostly m/z 922, which is a reference ion used for mass 

correction. 

 

 

 

 

 

 

Background area of chromatogram is high-

lighted in gray. 

Background mass spectrum 



~ 12 ~ 
 

6) On the HPLC chromatogram, left-click and drag across the protein peak of interest to highlight 

it.  Then right-click the mouse to obtain a menu, and left-click “Extract MS Spectrum”.  In the 

MS Spectrum window, you should see the mass spectrum of the protein, showing a series of 

multiply-charged ions. 

 

 

 

7) The mass spectrum needs to be copied from the Spectrum Preview window to the Spectrum 

Results window, in order to process and deconvolute it.  To do this, right-click on the spectrum 

to obtain a menu, and left-click on “Copy to User Spectra”. 

 

The Protein peak is high-lighted on the HPLC 

chromatogram. 

The raw data mass spectrum of the protein, 

showing multiply charged ions. 
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8) Left-click and drag across the spectrum to highlight the series of multiply-charged ions. 

 
 

9) On the left hand side, under the Spectrum heading, click on Deconvolute MS: 

Maximum Entropy.  Enter a reasonable mass range.  (The wider you make the mass range, the 

longer it takes to complete the calculations).  Click on the Green arrow to start the process. 

 

Series of multiply charged ions have been 

highlighted. 

click on the green 

arrow to start the 

deconvolution, after 

the mass range has 

been set. 

 type in desired 

mass range here. 



~ 14 ~ 
 

 

10) After the calculation is complete, click on the Deconvolution Results tab to view the 

spectrum. 

 
You can zoom in on a particular region, by left-clicking and dragging. 

 
 

Spectra can be copied and pasted into a Word or Powerpoint document. 

 

If you need to zoom out to the full spectrum, click on the diagonal arrow on the spectrum 

toolbar. 

 

 Diagonal arrow is used for zooming out. 
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How to Shut Down When You Are Finished 

 

1) Put the Instrument in Standby, by clicking on the Standby button. 

 
 

2) Exit from the Data Acquisition program.  Exiting from the Data Acquisition program is what 

logs you off, so that no more time is billed to your account. 

 

3) Remove the Poroshell HPLC column. 

 

4) Install a union in place of the column, to prevent solvent from leaking out of the tubing. 

  

Click on the Standby button to put the 

instrument in Standby mode    
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Peptides 
1)  Go to the File menu, and click on Open Method…. 

 
 

2)  Choose the method called “Student_Peptides”. 
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3)  Install the ZORBAX 300SB-C18 column.  Note that the flow direction is left to right.  The left 

side is the high pressure side, and requires a nut and ferrule.  The low pressure side on the right 

only requires a one-piece PEEK fitting. 

 
 

 
 

 

 

High Pressure Side 

Low Pressure Side 

Flow direction is left to right  
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4) Set the initial solvent flow to 95% acetonitrile with 0.1% formic acid, and 5% water with 0.1% 

formic acid, at a flow rate of 0.5 ml/min, using the “1290-Bin Pump” tab on the method editor.  

Click on the “Apply” button. 
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Click on Apply after making any changes   
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5)  Put the instrument into “On” mode. 

 
 

6)  Turn on the Reference Mass ions, using the Q-TOF and Ref Mass tabs. 

 
 

 

 

Click on the On button  

 Click on the Apply Now button to 

turn the reference masses on. 
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7)  After the column has conditioned for 5 minutes, change the gradient to 95% water with 0.1% 

formic acid, and 5% acetonitrile with 0.1% formic acid. 

 

8) Sample Preparation: 

The protein sample should be desalted, and dissolved in water with 0.1% formic acid.  The 

concentration should be at least 0.1 mg/ml.  The minimum volume would be 10 ul if using a 

conical bottom insert in the vial.   

 

Important!  The sample must be filtered to remove any particulate matter. 

 
 

9) Place the sample in the Autosampler compartment, and note its position.  It’s position is 

designated by the plate number, followed by a dash, and then the well letter and number.  For 

example,  P1-D1 would be plate 1, row D and column 1. 

 

Typical 0.2 ml vial insert. 

 

 P1-D1 
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Click on the “Sample” tab in the method area near the bottom of the page, to set up the data 

acquisition. 

The required parameters to set are the sample position in the autosampler tray, a data file name, 

comment, and injection volume. 

 
 

10) Click on the Start Run icon. 

 
 

 

 

 

 

 

 

 

 

Start Run  
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Peptide Data Workup After the Run Has Completed 

 

1)  Launch Agilent Qualitative Analysis Program. 

 

2) After the program comes up, go to the Tools menu, and Configure Workflow for “General”.  

Click OK and click on “No” to saving method changes. 

 

3) On the left hand side, expand the “Spectrum” heading by clicking on the “+” sign in front of it.  

Then click on “Extract(MS)”.  The method editor will come up, and you will need to change the 

drop down menu choice from “None” to “Current background spectrum”.  This will set up 

automatic background subtraction. 

 

 

 change from “None” 

to “Current background 

spectrum” 
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4)  Next, open your data file, using File and Open. 

 

5)  On the HPLC chromatogram, left-click and drag across an area of background baseline with no 

peaks, in order to highlight that area.  Then right-click the mouse to obtain a menu, and left-

click “Extract MS Spectrum to Background”.  You should see a background spectrum in the 

MS Spectrum window, showing mostly m/z 121 and m/z 922, which are reference mass ions 

used for mass correction. 

 

 

Background mass spectrum, showing the 

reference ions m/z 121 and m/z 922. 

Blank baseline area 

of the 

chromatogram is 

highlighted in gray. 
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6)  On the HPLC chromatogram, left-click and drag across a peptide peak of interest to highlight 

it.  Then right-click the mouse to obtain a menu, and left-click “Extract MS Spectrum”.  In the 

MS Spectrum window, you should see the mass spectrum of the peptide.  The background 

spectrum is automatically subtracted from this spectrum, so there should be little or no presence 

of m/z 121 and m/z 922. 

 

 

A peptide peak is highlighted in gray on the 

HPLC chromatogram. 

The mass spectrum of the peptide peak is 

displayed in the Spectrum Results window.  

The spectrum shows a small [M+H]+ 

molecular ion, as well as multiply charged 

ions [M+2H]++ and [M+3H]+++. 

 [M+H]+ 

 [M+2H]++ 

[M+3H]+++   
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7)  To deconvolute the spectrum, first check the parameters in the deconvolution method.  To do 

this, under the “Spectrum” heading on the left-hand side, click on “Deconvolute: Resolved 

Isotope”.  A dialog box will come up.  Under the “Charge State” tab, make sure that the Isotope 

Model is set to “Peptides”, and the charge state maximum is set to 5.  Click on the green arrow 

to do the deconvolution. 

 

 
 

 Isotope model should be set to 

“Peptides” 

 charge state maximum should be set to 5. 

After the parameters ↑ 

have been set, click on 

the green arrow to do 

the deconvolution. 



~ 27 ~ 
 

After the deconvolution has been done, you will see the deconvoluted spectrum in the 

Deconvolution Results window.  This spectrum will show the monoisotopic mass of the peptide 

without additional protons or charges. 

 
 

Note:  Once your parameters have been set, from then on you can obtain a deconvoluted 

spectrum simply by right-clicking the mass spectrum to get a menu, and then left-click on 

“Deconvolute (Resolved Isotope)”. 

 

8)  Other peptide peaks can be worked up in the same way.  Here are some useful things to know 

about peptide spectra: 

 

If an ion is singly-charged, then the spacing between adjacent isotope peaks will be one Dalton. 

 

Deconvoluted mass spectrum with resolved 

isotopes and monoisotopic mass. 

This is a singly-charged 

[M+H]+ ion.  It has a 

spacing of one Dalton 

between isotope peaks. 
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If an ion is doubly-charged, then the spacing between adjacent isotope peaks will be 0.5 Dalton. 

 

 

 
 

If an ion is triply-charged, then the spacing between adjacent isotope peaks will be 0.33 Dalton. 

 

 
 

 

 

 

 

This is a doubly-charged [M+2H]++ ion.  

The spacing between isotope peaks is 

0.5 Dalton. 

This is a triply-charged [M+3H]+++ ion.  

The spacing between isotope peaks is 

0.33 Dalton. 
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You can calculate the theoretical monoisotopic masses of the various ions by clicking on the 

“Tools” menu, and clicking on “Show Mass Calculator”.  Type in the molecular formula of the 

neutral molecule in the “Base Formula(M) field.  Select “Positive ions” and click on the “+H” 

option.  Set the number of charges.  If you wish, you can type in the observed value in the 

“Comparison m/z” field, and it will calculate the difference between the observed and 

theoretical values.  Click on the green arrow to do the calculation. 
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How to Shut Down When You Are Finished 

 

5) Put the Instrument in Standby, by clicking on the Standby button. 

 
 

6) Exit from the Data Acquisition program.  Exiting from the Data Acquisition program is what 

logs you off, so that no more time is billed to your account. 

 

7) Remove the ZORBAX 300SB-C18  HPLC column. 

 

8) Install a union in place of the column, to prevent solvent from leaking out of the tubing. 

  

Click on the Standby button to put the 

instrument in Standby mode    
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